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Sending Faxes

There are three ways to send a fax with RightFAX:    RightFAX PowerBar, Embedded Codes, or    FaxUtil. 

RightFAX PowerBar
The RightFax PowerBar is a special program that works with Windows to make your faxing easier.    
When you use it, the PowerBar pops up a dialog box that prompts you for the information required to 
send a fax.    e.g. name and fax phone number.

Embedded Codes
Embedded codes are special command statements which you enter into a document.    RightFAX will 
interpret and remove them from the fax.    These special command statements tell RightFAX the name 
and fax phone number of the person to which to send a fax.    For example, <TO_NAME:John 
Doe><TO_FAXNUM:555-1234>.    Embedded codes can be used from any DOS, Windows, OS/2, Unix, 
mainframe, Macintosh, or other computer which can print to a network print queue.

FaxUtil
If you don't want to use either Embedded Codes or the RightFAX PowerBar, you can address a fax from 
your fax mailbox.    Once you've printed your document to the fax queue, you can edit the cover sheet 
information from FaxUtil.



RightFAX PowerBar

The RightFAX PowerBar is a special way to send your faxes using Windows pop-up dialog boxes.

To send your fax through the PowerBar open    the document that you want to fax.    Make sure that your 
fax printer is selected on the RightFax PowerBar.    Then from a Windows application (like Word for 
Windows) Print your document using your application's Print capability.

The following window will appear on your screen:

 

To address the fax, fill in the name, fax number, and other information for the person that you want to 
send the fax to.    Click OK.    The fax is now on its way.

Installing the Power Bar 



Embedded Codes

Embedded codes are special instructions which you may insert into documents or text files.    They give 
RightFAX the cover sheet information needed to send faxes to their destinations.    Embedded Codes Also 
allow you to send faxes without opening FaxUtil or using the RightFax PowerBar.    You can use 
embedded codes in custom programs to communicate information to RightFax.    You may also use them 
to include signatures in a document.    Any Code with a "(G)" following it is usable though the RightFAX 
Email Gateways.    In other words you can include these codes in your faxes sent from email gateways to 
RightFAX.

To see information on a specific embedded code, click on any word below.

ADDDOC
ADDDOC2 
ATDATE (G)
ATTACH 
ATTIME (G)
AUTODELETE (G)
AUTODELETEALL (G)
    
BILLINFO1 (G)
BI1 (G)
BILLINFO2 (G)
BI2 (G)

CALLBACK    (G)
CHANNEL (G)
COVER (G)

DELETE (G)
DELETEALL (G)

FCSFILE (G)
FINE (G)
FORMTYPE
FROMFAXNUM (G)
FROMGENFAXNUM (G)
FROMGENPHONE (G)
FROMNAME

GRAPHIC

LIBDOC (G)
LIBDOC2 (G)

NEWDEST
NEWLIB
NOCOVER (G)
NOBODY
NORMAL (G)
NOTE

PREVIEW
PRIORITY (G)

SAVE (G)



SIGNATURE

TOCITYSTATE (G)
TOCOMPANY (G)
TOCONTACTNUM (G)
TOFAXNUM (G)
TONAME (G)



Product Support

If you have a question about FaxUtil or the Fax Viewer, first contact your system administrator.    If your 
fax administrator is unable to help, you may contact us or have your administrator contact us at:

RightFAX Technical Support
4400 E. Broadway
Suite 312
Tucson, AZ    85711
USA

Voice: (520) 327-1357
Fax: (520) 321-7461
BBS: (520) 327-7456
E-Mail: tech@rightfax.com

Please include your RightFAX serial number.    It can be found on the inside front cover of your "RightFAX 
Customer Support Guide" booklet, your version of RightFax, operating system and version, and network 
and version.    The more relevant information you provide to us the more easily and quickly we will be able 
to help you.



Getting Started

In this tutorial, you will create, send, and receive a fax.    For this example, you will send a fax cover page 
to yourself. 

To skip to the section on sending an entire fax, see Sending a Fax.

Step 1: Creating the Cover Page

To create a new fax, press the  button.    The Fax Information window will pop up.    Each of the 
blanks on this window are called fields.    You can move between fields using the mouse or the tab key.    
All italicized fields must be completed; all others are optional.

In the field labeled "Name", type the name of the person who will receive the fax.    Next, enter the 
destination fax number in the "Fax Number" field (this could be a thermal fax machine in your company, or 
if you have your own RightFAX number, enter it.) 

Press the Notes button; to add comments to the cover sheet.    Type in some notes and press OK.    Back 
in the Fax Information window, send the fax by pressing OK.

At this point, RightFAX is in charge of delivering the fax.    You can watch the progress of the fax.    In your 
Fax Mailbox, you should now see a new listing for the fax.    The right-most column of information 
represents the fax's status.    The fax's status will go through four stages:

Waiting for Conversion
Scheduled to be Sent
Sending
OK

As soon as the status line reads "OK" there should be a new fax in your RightFAX mailbox or your 
thermal fax tray.

Continue 
Return to Index 



Step 2: Viewing a Fax

Select the fax that you have just sent to yourself and press the  button.    In a few seconds, the 
RightFAX Fax Viewer will appear, showing the cover sheet.    You may scroll through it with your mouse, 
and change the view with the toolbar.

You just sent your first fax using RightFAX.    Now You can try sending a fax from a Windows application, 
probably the most commonly used method of faxing with RightFax.

Continue 
Return to Index 



Step 3: Sending Faxes From Applications

From a word processor (or any other application), open a document to fax.

Select the Fax queue though the PowerBar and    print the file.    RightFAX may give you a small login 
window.    If so enter your RightFAX user ID and password.    A window like this will appear on your screen:

 

Complete any required information in this window and press OK.    RightFAX will send this document out 
as a fax. 

Now go into faxutil, the new fax should be listed in your Fax Mailbox.    Note that in the "Size" column, it 
reads "CS + ?" for the new fax.    This translates to "Cover Sheet plus the number of pages long the 
document is."    You may watch the fax go through its conversion and sending processes.    Make sure that 
it has been sent correctly to the number that you specified on the RightFax Header window.

Continue 
Return to Index 



Step 4: Printing Your Fax

To print a copy of the Fax, Highlight the fax with the mouse, then click on the  button.

You will be presented with the traditional Windows "Print window".    Select the desired printer in the top 
field. Check the other settings in the window to ensure that they are the way you want them.

Click OK.    You will get a new message notifying you that your faxes have been queued for printing; once 
they have been printed, you will see a tiny printer emblem appear in the P column to the far left of your 
Fax Mailbox.

You now have at least two faxes in your Fax Mailbox; one that was just a cover sheet, and one that you 
sent from an application.

Return to Index 



Menu Commands

File Menu
Edit 
Delete 
Show History 
Release 
Kick 
Forward to Fax Machine 
Forward to Network User 
Route to Network User 
Exit 

Fax Menu
New 
View Body 
View Cover Sheet 
Print 
OCR 
Combine 
Record Thermal Fax 
Store In Library

Data Menu
New 
Launch 
Print 
Export 

List Menu
Full Fax List 
Sent Fax List 
Received Fax List 
Phonebook 
Switch Mailboxes 
Return to Original Mailbox 
Update List 

Options Menu
Send Fax Options 
Receive Fax Options 
Cover Sheet Information 
Notification 
Change Password 
Other 
Choose Font 

Toolbar 



Full Fax List

Shows a complete listing of all faxes sent and received from this user account, or Fax Mailbox, 

See also:
Newest to Oldest.
Sent Faxes
Received Faxes



Sent Fax List

Lists only sent faxes.

See also:
Newest to Oldest
Received Faxes



Received Fax List

Lists only received faxes.

See also:
Newest to Oldest
Sent Faxes



Phonebook

Switches to the personal Phonebook for this user account.    From the Phonebook you can store 
frequently used names, their associated fax phone numbers, and other related transmission information. 
By using the Phonebook,    you don't have to enter numbers, names, or billing information each time you 
want to send a fax to people with whom you regularly communicate.

You can also call up the Phonebook by pressing the  button on the toolbar. 

Phonebook 



Switch Mailboxes...

Jumps from your account to another.    If you do not have FaxAdmin privileges, you will need to give the 
other account's password. 

 

Switching Mailboxes is useful if you want to check for incoming faxes on another account, or if you want 
to edit, view, forward or route existing faxes in that account.    You can work directly from this new account 
just as you would from your own.    Remember, though, that if you have a personalized cover sheet and 
are configured to use it in your own account, you will not use it in the foreign account; you will use the 
cover sheet assigned to that person.



Return to Original Mailbox...

If you have switched into another user's Fax Mailbox, use this command to return to your own Mailbox 
and automatically log out of the foreign account.



Exit

Quits FaxUtil.    All faxes will still be sent and received for this mailbox; you do not have to be logged in to 
finish sending faxes or receive faxes.



About Fax Utility...

Provides information about which version of FaxUtil your workstation is running, the name of your fax 
server, release dates, etc.



View Body

Calls the Fax Viewer and displays the fax body image.    Note that you will NOT see your cover sheet 
here when viewing a sent fax; faxes and their cover sheets are separate images.    To view cover sheets 
for sent faxes, select View Cover Sheet from the Fax menu.

You can also press the  button to call the Fax Viewer.

See also: Fax Viewer 



View Cover Sheet

Calls the Fax Viewer and displays the cover sheet associated with the selected fax.    Note that you 
cannot view faxes with incomplete information, i.e. RightFAX has to create a fully complete cover sheet 
through a conversion process before allowing the image to be accessed by the Viewer.

View Cover Sheet will not work with received faxes because the cover sheet and the body are treated as 
one set of images, not two separate images.

See also: Fax Viewer 



Print Fax

Prints the highlighted fax to a network printer.    When the fax has been sent to the printer, a small printer 
symbol will appear in the column marked P.

To print a fax, highlight it, and then select Print from the Fax menu, or press the  button on the 
toolbar.    Select the desired network printer from the pull-down list, confirm all other choices, and click 
OK. 

 

Your fax will be sent to the print queue; once it has been sent to the printer, you should see the printer 
symbol appear next to the fax on the Mailbox list.

Note: To print faxes to local printers, you Must print them from the Fax Viewer.

Automatic Printing 



Show Transmission History

Displays a record of transmission for the highlighted fax.    Information includes, among others:

User ID
Date
Recipient Name
Fax Phone #
Channel Used
Number of Pages
Status of Fax (was it successfully transmitted?)

 

Note that RightFAX takes its transmission records from the fax boards themselves; sometimes the fax 
status from the board may be garbled and difficult for RightFAX to read or understand, hence an 
"Unknown Error".    GammaLink boards report a specific error number; refer to the GammaLink manuals 
for your board(s) for these error codes.

Received faxes will always have only one transmission history record associated with them.    Sent faxes 
may have multiple histories, one for each time the fax is sent.

You can also press the  to call the transmission history, after selecting a fax.



Edit (Fax Information window)

The Edit item on the File menu is one of the most powerful tools in FaxUtil.    When you highlight a fax 
with a status of "Info Not Complete" and select Edit, a window called "Fax Information" will appear.

 

This window also appears when you press the  button, select New from the Fax menu, or press the 
Insert key.    It represents the cover page and the information that will appear on it.    From this window, 
you may add or scan attachments, assign billing codes, import other documents, or perform a host of 
optional features.    You may enter a PhoneBook ID in the to name field and RightFAX will look up that ID 
and fill in the rest of the destination information for you.

See Also:
Phonebook Button Lookup 
Delay Send Hold for Preview 
Form Type Library 
More Notes 
Scan View 
Priority                                   Add Entry  



  

Note:    If you receive this error message, it means that your FAX COVER SHEET has already been 
imaged.    You CANNOT use Edit from the File menu to change an existing fax body OR its cover sheet. 
In order to change the fax body, you need to edit it from the original application where it was created.    In 
order to change the fax cover sheet, you need to highlight the desired fax, then choose "Forward to Fax 

Machine" from the Fax menu or select the  



New

 

New creates a new fax from your Fax Mailbox.    When you first select New, you will, by default, be 
sending only a cover sheet that you can edit from the Fax Information window.    You can select library 
documents, form overlays, or scanned attachments to add to your cover sheet from this window.

Alternately you can hold down the ctrl key while clicking on the OK button from the Fax Information 
Window.    This will send the current fax and new one will be created.    Just like selecting that fax and 
saying forward to fax machine.



Delete

 

Removes faxes from your Fax Mailbox.    Although the images of your faxes have been deleted, the 
database records for them have not (Unless you are set to AutoPurge you faxes, in FaxAdmin, in which 
case all information about the fax is deleted).    This allows creation of reports for cost recovery and billing 
purposes.

It is recommended that you clean up your Fax Mailbox frequently, as fax images can take anywhere from 
20K to 200K on your system, depending on the complexity of the image.



Combine

Allows you combine selected faxes from the Mailbox list.    Highlight several faxes that you want to send 

as one fax, and select Combine from the Fax Menu or press the  button on the toolbar. 

 

The faxes will be combined in the order that they appear on the screen.    If you want them to fax in a 
different order, you can change the order in the Combine window.    Use the up and down arrow keys next 
to the list to move a fax to the desired position; to complete the combine, press the Execute Combine 
button.    By default, RightFAX will combine all pages of all faxes, but you can specify which pages of 
which faxes you want to send.    Once a fax has been combined it can not be separated again.



Release

In co-operation with the Hold for Preview option in the Fax Information window, Release allows you to 
complete all information for a fax and hold it so that you may view both the cover sheet and the body 
before sending it.

Once you have ensured that everything is correct, select Release to send the fax to its destination.    A 
held fax will never send unless you release it using this menu item.



Store In Library

This feature allows the currently selected fax to be stored as a Library Document.    If you need to store a 
portion of a fax do a Combine first and than store the new "combined" fax as a Library. 

 

The ID Code is the code that will be used to refer to this document.    This would be used with the 
embedded code Libdoc / Libdoc2 or listed in the Library selection dialog.    The Description is a longer free 
form field.    Finally the Page Count denoted the number of pages in the Library Document being added.

See Also:
Library Documents



Record Thermal Fax

If your installation is designed to track fax billing information, you may want to keep track of the faxes 
received and sent from any free standing thermal fax machines at your site.    For this purpose RightFAX 
has the Record Thermal Fax option.    The Fax Information window appears when you select Record 
Thermal Fax, but you will notice that an extra option has been added that asks how many pages the fax 
contains and whether the fax was received or sent.    If you do not specify, RightFAX assumes the fax to 
have been sent.    After you have completed the information for a thermal fax, it appears on your fax list 
with "Thermal Record" in the status column.    You may edit or delete this entry just like any other fax 
entry.



Forward to Fax Machine

Enables you send or resend a fax already in your Mailbox.    To use this option, highlight the fax you want 
to forward from your Mailbox, then choose Forward to Fax Machine from the File menu, or press the 

 button.    A copy of the fax appears at the top of your fax list with status Info Not Complete.    Edit 
the fax and fill in the cover sheet information as you would do for any other outgoing fax.



Forward to Network User

Sends a duplicate of a fax in your Mailbox to another RightFAX user. 

 

Type the recipient's user ID in the area provided.    Note that this does not MOVE the fax from your 
Mailbox to another; it only creates a copy in the recipient's Mailbox.    In addition, you may enter text in the 
notes field.    (These get appended to the Fax History.)



Route to Network User

Unlike the forwarding options, Route to Network User does not create a copy of an existing fax to send 
another person.    Instead, it actually moves the selected fax to the new recipient's Fax Mailbox.    You can 

use the  button as well as the menu item to route faxes to other users.

 
 
Highlight the user who will receive the fax from the list of users in the top field.    To include any notes to 
this user in the transmission history, type them in the lower field and then click OK.    You may select 
multiple people to route to and they will all be able to see the fax.



Update List

If you want to update your Mailbox display without waiting for the window to automatically update (about 
every 10 seconds), or if you have automatic updating disabled, you may do a manual update.    Select 

Update List from the List menu or press the  toolbar button.

Automatic Updates 
  



New

If your company can send binary files from its RightFAX system, you can use the Data menu to send a 
computer file to someone else who has RightFax or another compatible system.    Binary File Transfer 
(BFT) works a lot like a modem except that it uses special computer fax cards.    This transfer looks just 
like a fax with a cover page and all the other fax features.

New pops up a window almost exactly like the regular Fax Information window, except that it's for data 
transfer (note the title of the window; it says Data Information rather than Fax Information.)

 
To tell RightFAX which file to transfer, press the Import button in the Data Information window.    You can 
then browse through your network and choose the file to transfer. 



 
Once you have chosen your file(s), tell RightFAX where to send it by completing all the required 
information just like you would for a fax.    Press OK to send the file. 



Binary Files

As RightFAX sends faxes it converts them into a "standard" fax format.    With the Binary File Transfer you 
can send the actual document, it is just like if you copied the file to disk and mailed it to the recipient.    A 
computer modem transfer is very similar to a BFT,    though with the modem transfer you don't get the fax 
cover page and other associated fax features.



Launch

If you have received a binary file and want to edit it as a normal document, choose Launch from the Data 
menu.    This will start the application where the document was created.

Launch also works with files that have been OCR'd.    If you have a fax that you have OCR'd, you can 
choose Launch to run the application that is associated with your file. 



Print

To print a binary file, choose Print from the Data menu, or press the  button on the toolbar.    
RightFAX will start the application with which your file is associated and print it from that application.



Export

Export allows you to save a file that you have OCR'd or received as a binary file to somewhere on your 
network or hard drive. 

 
It works just like the Save As function in most applications.



Kick Fax

Kick Fax tells RightFAX to immediately retry a send after a failed transmission attempt.    It is located in 
the File Menu.    Normally, when an error-retry condition occurs, RightFAX waits 5 minutes before trying 
again.    With Kick Fax you may tell RightFAX to retry the send immediately rather than waiting the 
standard delay.    After RightFAX has tried to send a fax and failed five times, it stops trying and considers 
the transmission failed.    This is called an error-dropped condition.    If you use Kick Fax after an error-
dropped, RightFAX will try to send one more time.    You may kick a dropped fax as many times as you 
like.

Note: If you set your automatic delete option to Always, your fax will be deleted as soon as the error-
dropped condition occurs, and you will not be able to kick the fax.



Send Fax Options

Send options can be set by selecting the Send Fax Options dialog box from the Options menu. 

 
Here you can set the resolution at which faxes are sent, the fax deletion options, cover sheet options as 
well as change your Default Priority.

See also: 
Fax Resolution 
Auto-Delete Settings 
Auto-Print Setting
Priority
Cover Sheet 



Fax Resolution

Faxes can be sent at two different resolutions: 100 x 200 dots per inch (DPI) standard/normal and 200 x 
200 DPI enhanced/fine.    A normal DPI works well for draft quality resolution and shorter transmission 
times, while the higher resolution DPI is recommended for high-quality printed documents and optical 
character recognition (OCR.)



Auto-Delete Options

Since fax images consume a considerable amount of space, you may want to tell RightFAX to 
automatically delete a fax after it is sent.    The disadvantage to using this option is that you will be unable 
to view what was sent, it will not appear on your fax list, and it cannot be forwarded.    However, enabling 
automatic deletion DOES NOT affect your original document.

Found in the Send Fax Options window, there are three settings for Auto-Delete:

Never 
Saves all fax data regardless of whether it was sent successfully.

Only if Successfully Sent 
Delete fax data only if transmission was successful.

Always 
Deletes sent faxes whether or not they were sent successfully.

The fax server will attempt to send each fax five times before the fax is classified as unsuccessfully sent. 
If the administrator has enabled Sent Fax Archiving for the mailbox, then automatic deletion is disabled.



Cover Sheet Options

RightFAX automatically creates and sends a cover sheet for you when you send a fax.    However, you 
may disable this feature by toggling off the Automatic Cover Sheets option in the Send Fax Options 
dialog box. 

 
Regardless of whether you have this option toggled on or off, RightFax still needs the basic fax routing 
information, such as the recipient's name and fax number.    When the automatic cover sheet option is 
selected, you can also adjust the resolution at which the cover sheet is sent from fine to normal.    These 
are the same resolution options that are available for the fax body.    From here you can adjust the Auto 
Delete Setting, control the Auto Printing of sent faxes and change the Priority.



Receive Fax Options

When a fax arrives in your fax Mailbox, RightFAX notifies you with a pop-up message.    Once a fax is in 
your Mailbox, you can view it, edit it, delete it, or send it to someone else.    You can also tell RightFAX to 
automatically process your fax: send it to another phone number or another user, automatically print; or 
OCR your fax (if your company has the separate OCR module.)

 

See also: Forwarding 
Printing 
OCR 



Automatic Forwarding

You can automatically forward a fax to another fax machine or another RightFAX user as soon as you 
receive it.    To enable automatic forwarding, select Receive Fax Options from the Options menu.    
Enable the check box marked "Automatically Forward Received Faxes?"    Next, choose whether you 
want to send your fax to another number or to a user on your network.    Specify the number or user in the 
appropriate box.

If for example you go away on business, you can have all your faxes automatically forwarded to the hotel 
where you are staying by enabling Automatic Forwarding and entering the fax number of the hotel.



Automatic Printing

You can automatically print all incoming faxes as soon as you receive them.    To enable automatic 
printing, select Receive Fax Options from the Options menu.    Enable the check box Automatically Print 
Received Faxes? and specify which network printer you wish to use. 



Automatic OCR

If you want RightFAX to automatically convert your faxes into editable documents, mark the 
Automatically OCR Received Faxes? box in the Receive Fax Options, and then set your OCR options 
to tell RightFAX how to OCR your faxes.

See also: Optical Character Recognition (OCR) 
Set OCR Options 



Set OCR Options

In order to convert your faxes from a graphic format into editable text format, RightFax runs them though 
an OCR (Optical Character Recognition) module. 

To setup RightFAX to correctly OCR your faxes, click on Set OCR Options in the Receive Fax Options 
menu.

 

In the Associations field, choose the application with which you want the OCR output to be associated.    
The application will be launched when the OCR output is viewed or printed.    If an application does not 
appear on the list, then it does not support OLE or has not been installed correctly.

In the Format field, choose how you want RightFAX to design your pages.    You have a choice of Smart 
ASCII, ASCII, or RTF (Rich Text Format).    ASCII will produce a plain text file, while Smart ASCII will 
approximate the format it was originally given.    RTF is not a human-readable format which preserves 
fonts and formatting.

In the Layout field you may choose between WYSIWYG (What You See Is What You Get) and Left 
Justified.    WYSIWYG will try to read the fax in the layout that it sees.    If, for instance, RightFAX sees 
that the fax has three columns, it will try to read the document in column style.    If you choose Left 
Justified, RightFAX will read from the left margin of the fax.



Cover Sheet Information

To set default cover sheet information, select Cover Sheet Information from the Options menu.    You 
can specify information to be placed on the cover sheets of all faxes, outgoing faxes only, or for incoming 
faxes only. 

 
For all faxes, there are three possible entries: your personal fax number (DID), your company operator's 
voice number, and the company's general fax number.    Your name, your phone or extension number, and 
whether you want the receiving party to call to confirm may be specified for outgoing faxes.    Some 
organizations like to fill in cover sheets for received faxes for billing purposes.    For this reason we have 
also included three fields that may be completed for received faxes:    To Name, To Company, and To 
City/State.    In order, these are your name, your company, and your address.



Notification

RightFAX can be configured to give you various types of notification whenever you send or receive faxes. 
This way you may work on other things and know the status of a fax as well.    By bringing up the 
Notification dialog box from the Options menu, you can tell RightFAX to notify you never, once only, or 
periodically when an outgoing fax needs more information, when a new fax arrives, or of your fax's status 
during transmission.

 
The next three notifications regarding sent faxes, "Error encountered: Fax will be retried", "Error 
encountered: Fax will be abandoned", and "Fax was sent successfully" may be enabled or disabled as 
you wish.

Error Messages 



Change Password

If you are on a system that requires a password, you should periodically change your password.    This is 
especially important if your fax materials are sensitive, proprietary, or classified.    To change your 
password, select the Change Password option from the Options menu. 

 

When the Change Password dialog box appears enter your current password and then enter your new 
password.    Enter you new password a second time in the confirmation field to verify it.    The new 
password will take effect the next time you use FaxUtil.    The password that you use to get into FaxUtil is 
the same password others must use to access your Mailbox unless they are the administrator.



Other

 
Automatic Fax List Updates
As a result of the potentially heavy work load on the server, it is impractical for the server to send constant 
updates to the client (FaxUtil) about its status.    Instead, messages are sent to FaxUtil at fixed intervals of 
every 60 seconds.    If you want your status messages updated more frequently, you can adjust the 
automatic update period to a minimum of 1 second.    You can also reduce the frequency of updates.    To 
change the update frequency, select Other from the Options menu.    Toggle the Automatic Fax List 
Updates check box and set the "Seconds between updates" field to the desired time between updates.

Default Network Printer
This allows you to choose which printer is automatically selected whenever you print a fax.    It does not 
rely on the Windows default printer so it will not effect your windows printer setup.

Fax List Sorting
RightFAX sorts and lists all faxes from newest to oldest by default.    You can change this by toggling the 
Oldest to Newest button in the Other window from the Options menu.



Choose Font

Choose Font, located on the Options menu, allows you to change the font FaxUtil uses in your Fax 
Mailbox display. 

 
This changes only the display, not the format of your faxes or cover sheets.



Delay Send

RightFAX normally sends outgoing faxes as soon as a phone line becomes available, but sometimes you 
may want to delay an outgoing fax.    To postpone the transmission of your fax, select the Delay Send 
check box in the Fax Information window and fill in the time and date fields.    Once you have completed 
the rest of the fax information, RightFAX converts the document to fax format and holds it until the 
designated date and time.    During this time, your fax will remain in the state Scheduled to Send.

Helpful Hint
To save money, use Delay Send to transmit faxes after 11:00 pm when phone rates are lower.



Hold for Preview

In conjunction with the Fax Viewer and Release , Hold for Preview gives you the opportunity to look at 
the final version of your outgoing fax before you send it. "Final version" faxes include a fax format body 
and a completed, converted cover sheet.    To view the fax highlight it and click on the view icon on the 
tool bar.    Then to send the fax select Release from the Fax menu.

See Also:<PREVIEW>



Forms

Allows you to select a form that your administrator has entered into the RightFAX database; letterhead (or 
another form type) can be combined with your fax to present a professional image to the recipient.    If, for 
example, you want to send a list of services from your company, Acme Cleaning, and you want to use the 
Acme Cleaning letterhead, select the Form Type option and choose the Acme Cleaning letterhead.    
RightFAX will then combine the letterhead image with the pricing quotes image to form one complete fax 
image which can then be sent as usual.

Note: You must have administrative privileges in order to create or edit forms.



Library Documents

Library Documents are pieces of frequently faxed data like company literature, credit applications or 
employment forms that the administrator has entered into the RightFAX database.    When you select a 
library document, it will be sent as the body of the fax. 

To send a library document, press the  button on the Toolbar or choose New from the Fax menu.    
From the Fax Information window, press the Library button. 

 
RightFAX will give you a new window with descriptions of frequently faxed company documents.    Choose 
one or more, then press Add.    You may delete or add to your list by highlighting a fax and then pressing 
the appropriate button.    Back in the Fax Information window, fill out the rest of your fax information.    
Your cover sheet will automatically be attached to the selected library document(s).



Phonebook Button

To quickly look up Phonebook entries from your or other users' Phonebooks, click on the  
Button in the To box of the Fax Information window.    This will bring up a window with all of your 
Phonebook entries, from which you may choose the desired entry.    If you want to look up an entry in 
someone else's Phonebook, choose the user ID in the bottom field, and click on Search. 

When you choose an entry, all the information that is in the Phonebook description of that person will 
appear on the cover sheet.    Remember that if the Phonebook description is not fully complete in that it 
doesn't fill out all required fields, your fax will still read "Info not Complete" in the Fax Mailbox.

For more information, go to Phonebook. 



Lookup Button

If you've forgotten your billing code or matter number, click on the  Button.

 
Here you may browse though the entries or search on a portion of a billing code or description by entering 
it into the appropriate box.    Then click on Search or press enter.    RightFAX will search for all entries 
beginning with that portion and display them so that you can choose your desired entry.

Note: When searching on descriptions, only the first 31 characters are used.



More

Found on the Fax Information dialog box window, More serves two purposes.

1.    If you are editing an outgoing fax, you can change your default Cover Sheet Information .      This 
allows you to change your contact information for this one fax only; it does not affect your default settings.

2.    If you are editing a received fax, you can enter information on the person who sent the fax to you, so 
that their name will be shown on the main fax list.

 
You can also edit received fax information by viewing the fax and then choosing Assign From Info from 
the Edit menu.



Notes

To add notes or comments to your cover sheet, click on the Notes button from the Fax Information dialog 
box.    You can enter 21 lines of comments which will appear on your cover sheet.    When finished 
entering text, click OK and finish filling out any other required information (Name, Fax Number, etc).

 
Note: Signatures cannot be placed on cover sheets.



Scan

Allows you to send hard copy through RightFAX using an HP ScanJet (or compatible) scanner.    
Scanning will always add pages to a fax, so you can scan attachments to an existing fax, or you can scan 
onto a fax with zero pages.

Scanning Documents 



Scanning Documents

You may scan documents it into RightFAX.    You may, for example, need to send a copy of a business trip 
receipt to your accountant.    To put a copy of the receipt into RightFAX, you may scan it into the computer 
using a member of the HP ScanJet family of flat-bed scanners or compatible.

To create a new fax using a scanned image, press the  button or select New from the Fax menu, 
and press the Scan button on the Fax Information dialog box.

 

Specify how many pages to scan in the "Number of pages to scan" box.

When you have made all of your choices, click on the Scan button.    RightFAX will prompt you to insert 
the first page into the scanner.    Do so, and press Enter.    RightFAX will prompt you after each page to 
replace it with the next one.

Once scanning is finished, click done and you will be returned to the Fax Information window to finish 
editing the cover sheet information.



Import

Allows you gather images from another area on your network and send them as a fax. 

 

Click on the New button from the Data menu then click on the Import button from the Data Information 
window and choose Add from the popup window.    The Add window allows you to move about the 
network in conventional fashion to choose any Group III files that you may have stored elsewhere. 

You can select one or more pages by dragging the mouse and highlighting those files.    When they have 
been added to the list in the Import window, you can change the order in which each page will be faxed 
by highlighting a file and then choosing "Move Up" or "Move Down" depending on where you want to 
move it.    The higher on the list that a page appears, the closer to the front of the fax it will be transmitted. 
Once you've selected a file, RightFAX will import it and make it the body of the new fax.



Group III

Group III is a type of file format that is accepted around the world as a fax standard.    RightFAX converts 
all outgoing documents to Group III via a conversion engine.    RightFAX can handle PCL5E (LaserJet) 
conversions, or PostScript conversions, depending on how your RightFAX administrator has configured 
your system.



View

The View button on the Fax Information window allows you to preview your outgoing fax without leaving 
the current window. 

Note:    The View button is only available after exiting the Fax Information window and reentering. 

Fax Viewer 



The Phonebook

One of the most useful RightFAX features is the Phonebook.    It allows you to store frequently used 
names, their associated fax phone numbers, and other related transmission information.    By using the 
Phonebook, you do not have to enter numbers, names, or billing information when you send a fax to 
someone who you fax to often.

You can access the Phonebook by pressing the  button on the toolbar.    The menu bar along the 
top of the window changes; the Fax menu is replaced by a Phone menu.

 

See Also:
Creating Individual Entries 
Creating Group Entries 
Copying Phonebook Entries 
Using the Phonebook to Send Faxes 
Importing Phonebook Entries
Printing Phonebook Entries



Creating Individual Entries

While viewing your Phonebook, press the  button on the toolbar or choose New from the Phone 
menu.    This calls the Phonebook Entry window.

Choose an ID for this individual.    This field MUST be completed.    You might want to associate it with the 
individual.    For example, if you are creating an entry for Ted Green, your marketing manager, you might 
assign it an ID of "Ted" or "Green."

Adjacent to the ID field is the Published check box.    If you select this option by placing an "X" in it, then 
everyone else will see this Phonebook entry when they switch to your Phonebook from the Fax 
Information window.    If you leave the box unmarked, then the entry is private and only you may access or 
view it.    Private entries are displayed with a small "lock" symbol on the left side next to each ID.    
Published entries have no symbol.



Creating Group Entries

To send the same fax to a number of different people, you may create a group containing their names, 
and then send the fax to that group rather than send it several individual times.    Like individual entries, 
groups may be published or private.

To create a Group, select group members from the Phonebook view.    Select up to 24 entries with the 
mouse.    To select non-consecutive entries, use the CTRL key and click on each desired entry.

Choose New Group from the Phonebook menu; a small dialog box will appear, prompting you for a 
group ID.    Enter an appropriate name for your group according to the same rules for entering individual 
entries.

HINT:    If you need to have more than 24 members in your group, create several subgroups and enter the 
ID's of the subgroups into the member fields of the main group.    This method gives you virtually unlimited 
mailing lists.



Copying Phonebook Entries

The Copy command in the Phonebook menu allows you to transfer the selected entries to another fax 
user on the network.    Highlight the entries you want to copy, select Copy from the Phonebook menu, 
and then enter the destination user ID when prompted.    Note that Phonebook groups can be copied as 
well as individuals.



Using the Phonebook to Send Faxes

There are three ways to access Phonebook entries:

Embedded Codes 
Phonebook Lookup 
To Name Field 



Embedded Codes

To use an Embedded Code for a Phonebook entry in your document, use the "toname" code as usual, but 
enter the Phonebook ID instead of the actual name of your fax recipient.

Syntax:
<toname:phonebook ID>
Example:
<toname:chuck>

To use another user's Phonebook entry, enter their user ID followed by an exclamation point, then the 
Phonebook ID that you want:

Syntax:
<toname:userID!phonebook ID>
Example:
<toname:JJC!mary>

Embedded Codes 



Phonebook Lookup

To use the Phonebook Lookup, edit your incomplete fax from your Fax Mailbox, and press the  
button; you will be presented with a pop up window listing all of your Phonebook entries.    Scroll through 
the list until you find the desired entry, highlight it, and then press OK. 

 
To search another user's phonebook for an entry, you may switch into their Phonebook by entering the 
user's ID in the lower field, then pressing the Search button.    You will be presented with a list of their 
published Phonebook entries.    Scroll through the list until you find the desired entry, highlight it, and then 
press OK. 

Note: When you poll another user's Phonebook, you will NOT be able to see their private entries; only 
published entries will appear.



To Name Field

If you already know the ID of your Phonebook entry, just enter that ID into the To Name field of your Fax 
Information window; all pertinent information will be entered into the remaining fields.



Importing Phonebook Entries

You may import Phonebook entries from an existing database or file outside of the RightFAX program.    
Choose the Import option from Phone menu; the Phone Import Specification dialog box will appear.    
Use this dialog box to enter information about the source file of your phone data.

 
The first field, File Name, is used to specify the name of the file containing the import data.    This file must 
be a pure text file -- it cannot be a specially formatted file such as the type created by a word processor.    
If you do use a word processor to create an import file, save the file to PLAIN TEXT or ASCII.

Next, you need to specify how the file is delimited; that is, how is each field separated?    Select commas, 
tabs, or spaces.

You also need to tell RightFAX if the strings are enclosed in quotation marks.    A string (short for "string of 
characters") is a computer term for a line of text -- this sentence, for example, is a string.    Some 
database export programs put quotation marks around strings.    If the program you are using inserts 
quotes, you will need to check the Quotes Around Fields box.

Also check whether you want these new entries to be marked as private or published entries.    Check the 
Published box if you want other people to be able to poll your Phonebook for these entries.

See also: Import File Specifications 



Import File Specifications

When importing your phonebook entries into FaxUtil, you need to tell RightFAX which fields to expect.    
To do this, include in your text file a first line containing the names of the fields surrounded by quotes.    If 
you do not include this first defining line, RightFAX will not know where to add your information, and the 
import will fail.    For example:

"ID","Name","Fax1","Company","City/state" 
"OJ","Julius","707-345-9876","Acme Oranges","Navel Arizona"

The above example, RightFAX is told that the first field will contain the phonebook ID, the second will 
contain the name, and so on.    The second line (and every line thereafter) will contain the information 
about the phonebook entries to import.    The fields in this file can be comma, tab, or space delimited.

Field Code Length Limits

Field Code            Maximum Width
ID 17
Name                               60
Company 60
Address 60
CityState 60
Fax1 32
Fax2 32
Voice1 32
Voice2 32
BillCode1 18
BillCode2 18
Notes 128

Note: The ID field is REQUIRED.    All other fields are optional.



The Fax Viewer

The Fax Viewer allows you to view your faxes without printing them to paper.    This saves both paper and 
physical filing space.    Any fax in your RightFax mailbox can be viewed on your computer screen using 
the FaxUtil program.    To view a fax, start the FaxUtil program, then highlight the fax that you want to 

view.    Press the  button on the toolbar.    RightFAX will show the entire fax including the cover 
sheet (when viewing received faxes, and the only the body of sent faxes.)    Use the View Cover Sheet 
option to view the cover sheet of a sent fax.    The reason the cover sheet is treated separately from the 
fax body is so that one fax body can be attached to multiple cover sheets. i.e.    you can send the same 
fax body to several people.

Note the toolbar at the top of the Viewer window; the buttons on this toolbar display most of the tools used 
in the Viewer (this makes for quick and easy viewing.)    These buttons are described below.    Though if 
you prefer to use menus those are available too.    (See Fax Viewer Menu Commands) 
 

 Cut, Copy and Paste:    Used to edit selected sections of the viewed image. 
 

 Page Orientation:    Used to rotate the viewed image.

 Image Size:    Used to scale the image. 

 Box View:    Used to view and select portions of the image.

                                 Clipboard:    Used to select an area and paste into it.

                                 Select:    Used to select an area in order to cut, copy, or paste.

                                 Pan:    Used to quickly scroll through the image.

                                 Binoculars:    Used to magnify a selected area of the fax into a separate window.

                                 Magnifying Box:    Used to magnify a selected area.

                                 Text Annotation:    Used to select an area and insert text into it.    Text is sized to fit 
into the selected area.

 Page Change:    Used to view the previous or next pages of each fax.



Fax Viewer Menu Commands

Eight main menus are available in the Fax Viewer.    With them you may manipulate the fax and modify 
your view.    There is also a ToolBar to help you in viewing the fax

File 
Edit 
Rotate 
Zoom 
Options 
Page 
Help 
Windows 



Windows

This menu allows you to tile windows for ease of viewing.



File

Close
Save
Save As 
Print
Printer Setup
Exit

These are all options generally available to Windows users.    Only one of these options is different from 
normal Windows File menus; Save As.

Save As allows you to export the viewed fax to a different format than the current Group III .



Save As

In order to export fax files from a RightFAX Group III format, you need to view the fax (highlight the fax, 

then press the  button) and select Save As from the File menu in the Fax Viewer.

You may save a fax; in DCX, PCX, TIFF, or Group III format.    Note that most drawing programs read 
DCX, PCX, and TIFF files.    Choose a drive, directory, and file name along with the file format, and click 
OK.    RightFAX will proceed with the export, page by page, and will notify you of any encountered errors.



OCR (Optical Character Recognition)

In order to use the text in a fax for more than simple on-screen viewing, editing, or printing, you need to 
convert it from its existing fax format into a text format.    Once this is done, you may manipulate the text in 
any way you wish, like loading it to a word processor for editing.

How successful the OCR program is at converting the fax image depends largely on the quality of the fax. 
A great deal of garbage or "noise" in the image will confuse the OCR program and produce unreadable 
results.

To OCR your fax, highlight it and then press the  button or choose OCR    from the Fax Menu.    
RightFAX will create from the fax image a text file in the format specified and mark it with a little "page" 
under the 'B' column of the fax list.    This means that the fax exists in both fax and OCR formats.

 

In the Output Type field, choose what kind of application you want RightFAX to use as a basis for 
converting your fax.    If your application type is not listed here, then you need to run REGEDIT from the 
Program Manager File menu, and add your application to the Windows Registry.

In the Format field, choose between ASCII, RTF or Smart ASCII.    ASCII will produce a plain text file, 
while Smart ASCII will approximate the format it was given.    While RTF will produce a Rich Text Format 
formated file.

In the Layout field, choose between WYSIWYG (What You See Is What You Get) and Left Justified.    
WYSIWYG will try to read the fax in the layout that it sees. If, for example, RightFAX sees that the fax has 
three columns, it will try to read the document in column style.    If you choose Left Justified, RightFAX 
will read from the left margin of the fax.

Once the OCR process is complete, you can edit the translated files by choosing Launch from the Data 
menu.    This will start the application (if you have it) with which the fax is associated.





Edit

Copy
Cut
Paste
Make Signature 
Make Graphic Object 
Assign From Info 

Cut, Copy and Paste do the usual.    In order to select anything to cut, copy, or paste, you must choose 
the Select Box from the Toolbar.    (The Select box is a clear rectangular box with dotted borders.) 

To paste a graphic object into a fax, choose the Clipboard, and select an area on the fax where you want 
to paste.    RightFAX will scale the image according to your selection; if the object is larger than the area 
selected, RightFAX will shrink the object to make it fit into that area.    Note: You will remain in Paste mode 
until you select another type of Box View from the Toolbar.    In order to paste, you must choose the 
Clipboard box from the Toolbar. 

Make Signature and Make Graphic Object are ONLY available to those people with RightFAX 
administrative privileges.

Assign From Info lets you tell RightFAX who the fax is from so that their name appears in the main fax list.



Assign From Info

This dialog box allows you to edit the From information for a received fax.    This will make the sender's 
name be displayed in RightFax mailboxes. It also allows lets you assign billing information to this fax for 
cost recovery purposes or any other use.

 

The fields here may be required see your    RightFax Administrator for more information. 



Make Signature

To personalize outgoing faxes, RightFAX offers you the ability to add signatures to documents destined 
for transmission.    Signatures are stored as graphic images in the \Rightfax\Sig directory and information 
concerning them is recorded in FaxAdmin.

To create a signature object, either fax yourself a copy of your signature, or scan it into RightFAX as a 
new fax.    (Press Insert to create a new fax, then from the Fax Information window, press the Scan 
button to scan your signature.)

View the new fax, and choose the Select box from the Box View Toolbar.    (The Select box is a clear 
rectangle with dotted edges.)    With the mouse, select your signature, then choose Make Signature from 
the Edit menu in the Fax Viewer.

You will be presented with an "Edit Signature" dialog box to complete.    Designate a Signature Code, 
User ID, and Description for the signature.    Specify which users, by ID, can use this signature in their 
faxes.    The owner of the signature is not implicitly authorized to use it, so be sure to include their user ID 
in one of the Authorized Users fields.

Note:    That only users with RightFAX administrative privileges can make Signatures or Graphic Objects.



Make Graphic Object

The Graphic Library serves two functions: it stores images of regularly faxed documents such as product 
literature, and it stores records of graphics, such as logos, which you may embed in your document, 
much the same as a signature.

To create a Graphic Object first scan the image into RightFAX, or fax it to yourself.    View the fax.    
Select Make Graphic Object from the Edit menu.    Give the graphic an ID and a description. 

Note:    Only users with RightFAX administrative privileges can make Graphic Objects.



Rotate

The Rotate file menu corresponds to the four buttons on the toolbar that look like pages with arrows on 
them.    Each button or item on the Rotate menu represents a different 90 degree rotation of the current 
page.



Zoom

Zoom in 50% 
Zoom out 50% 
Zoom In a Little 
Zoom Out a Little 
Fit Width 
Fit Page 

The Zoom menu items correspond to the five center buttons containing the various zoom options.



Zoom In 50%

The fax image will appear twice as large as before; corresponds to the  button on the toolbar.



Zoom Out 50%

The fax image will appear one half the size it was before; corresponds to the  button.



Zoom In a Little

The scale of the fax image is increased by 2% each time you select this item from the Zoom menu (or 
press ctrl +). This menu item has no corresponding toolbar button.



Zoom Out a Little

The fax image will be decreased by 2% every time you select this item from the menu or press (ctrl -).    
This item has no corresponding toolbar button.



Fit Width

Scales the fax image so that the width of the text lines fills the View Window.    Corresponds to the  
toolbar button.



Fit Page

Scale the fax image to display the entire page in the window.    Corresponds to the  toolbar button.



Options

Enhance Image 
Scale Speed 
Image Type 
Invert Color 
Clip at Screen Ratio 
Set Clipping Ratio 
Save Settings on Exit 

The Fax Viewer offers various options or preferences for viewing faxes.    You can tell RightFAX what kind 
of image it is displaying in order to optimize the display of the image.    You may also change the image 
according to your wishes.    For example you can choose the size at which you wish to cut and paste parts 
of the image.



Enhance Image

All fax images are by default displayed unenhanced; that is, all recordable specks and letter edges will be 
shown.    In order to soften letter edges and gray out irritating specks, select Enhance Image from the 
Options menu in the Fax Viewer.    This procedure is known as anti-aliasing.



Scale Speed

You may decide that a sharper image is more important than imaging speed, or vice verse.    So we offer 
the ability to customize this option.    If speed is more important, choose Best Speed from the Scale 
Speed item on the Options menu.    If a sharper image is more important, choose Best Quality instead.



Image Type

You can tell RightFAX what kind of fax you're viewing and it will adjust itself accordingly.    The choices are 
Text, Line Image, or Photo.      Text is the least exact and Photo is as clear as possible.



Invert Color

You may have receive a fax that is hard to view with black characters on a white background.    To remedy 
this situation simply choose Invert Color from the Fax Viewer Options menu.



Clip at Screen Ratio

Tells RightFAX that you wish to cut out images or parts of images and paste them to the Windows 
Clipboard at the same size that you see them on screen.      If you want to clip at a different size or ratio, 
choose Set Clipping Ratio from the Fax Viewer Options menu.



Set Clipping Ratio

Tells RightFAX that you want to cut and paste an image or images from the Fax Viewer to the Windows 
Clipboard at a different ratio than what you see on screen.



Save Settings on Exit

Tells RightFAX that you want the Fax Viewer to look and act the same, as it is now, the next time you view 
a fax.    You can toggle this option on or off (a check is on.)



Page

First
Next
Previous
Last
Goto Page

These menu items you view different pages of the fax.    If you have only one page, most or all of these 
will be grayed out and not selectable.



Image Information

This provides you with statistical information regarding the current page.    Information supplied includes 
height, width, resolution, orientation, mode of compression, color, and others.    This can be used in 
debugging.



Help

About RightFAX Fax Viewer 
Image Information 



About RightFAX Fax Viewer

This tells you which version of the Windows Fax Viewer you are currently running.



Attach

Example: <ATTACH>

Indicates that you wish to scan attachments to this fax.    The fax will be held in FaxUtil until scanned 
images are added.    For example, you may wish to append scanned sketches or diagrams to a fax 
document created in a word processor.    After you have attached the additional images, RightFAX 
generates the cover sheet and sends the fax.    This code does not attachment native documents from 
applications or other graphic files (see ADDDOC or LIBDOC for such functionality).



ATDATE

Examples: <ATDATE:12-12-93>
<AT_DATE:3-22-93>

Schedules the fax to be sent on a specific date.    There are two different ways to express date:    relative 
or absolute.    Relative dates give the number of days from today's date; for example, "+7" would be a 
week from today.    Absolute dates are in the format: MM/DD/YY, MM-DD-YY, or MM-DD-YYYY.    The 
absolute date format does not change for different countries.

If only a date is specified, i.e. no AT_TIME is used, the time is assumed to be now.    For example, if a fax 
is sent to the queue at 3:30pm and it contains <ATDATE:+1>, it will be scheduled for 3:30pm tomorrow, 
not at midnight tomorrow.

See also: <AT_TIME>



ATTIME

Examples: <ATTIME:5:12p>
<AT_TIME:2200>

Schedules the fax to be sent at a specific time.    There are two different ways to express the time value: 
relative and absolute.    Relative time values are in the format '+#', e.g. <ATTIME:+1> schedules the fax 
for one hour from "now".    An absolute time value is entered in either 12 or 24 hour format, a colon 
separating hours and minutes is optional.    All the following are valid examples of absolute time values: 
<ATTIME:1722> <ATTIME:0800> <AtTime:8:00a> <AT_TIME:10:00p> <At_Time:0659p>.    The fax 
server may not send the fax exactly at the minute specified.    Rather, the fax becomes eligible for 
scheduling onto an available outgoing fax line with +/- 15 minutes of the time specified.

Scheduling a fax for times past midnight and before the current time are actually scheduled on "today's" 
date, so the fax is immediately eligible for scheduling.    If, for example, you want to schedule the fax for 
3am in the morning tomorrow, you need to use the codes: <ATDATE:+1><ATTIME:0300>.

See also: <AT_DATE>



BILLINFO1 & BILLINFO2

Examples: <BILLINFO1:99999>
<BILLINFO2:99999>
<BI1:99999>
<BI2:99999>

Attaches a billing code to a fax.    If your system administrator has configured the system to require and/or 
verify the validity of billing codes, you must enter a valid billing code here else the fax will not be sent.    
The billing code data, i.e. the text following the colon, can be a maximum of 15 characters.

Each fax may have two possible billing codes.    BILLINFO1 (or BI1) supplies the first code, and 
BILLINFO2 (or BI2) supplies the second.    BI1 is synonomous with BILLINFO1 and BI2 is synonomous 
with BILLINFO2.



CALLBACK

Example: <CALLBACK>

Notifies the fax recipient, by entering yes in the call back blank on the cover sheet, to call and confirm 
receipt of the fax.    If, in FaxUtil, your default Call-Back is enabled, then this embedded code has no 
effect.



DELETE

Examples: <DELETE>
<AUTODELETE>

Specifies that the fax should be deleted after successfully sent; overrides any default auto-delete setting. 
If the fax fails too many times, it will NOT be deleted and it will remain in the fax mailbox with the status 
"ED:message".    If the administrator has enabled Sent Fax Archiving for the mailbox, then automatic 
deletion is disabled.

See also: Document Delete Options 
<DELETEALL>
<SAVE>



DELETEALL

Examples: <DELETEALL>
<AUTODELETEALL>

Specifies that this fax should be deleted after being sent, whether or not the send was successful; 
overrides any default auto-delete setting.    If the administrator has enabled Sent Fax Archiving for the 
mailbox, then automatic deletion is disabled.

See also:    Document Delete Options 
<DELETE>
<SAVE>



FINE

Example: <FINE>

Tells the fax server to convert the body of this fax using Fine mode (200 x 200 DPI resolution).    Overrides 
the default mode (200 x 100 DPI) set in FaxUtil in the Send Fax Options menu item.    Higher resolution 
faxes look better, but they take longer to send, thus they are more costly.

See also:    Fax Resolution 
<NORMAL>



FORMTYPE

Example: <FORMTYPE:letterhead>

Causes faxes to be imaged onto a specific form or paper to give the effect that the document was printed 
on the form/paper and then faxed.    Forms and paper types have to be setup by the system administrator.



FROMFAXNUM

Examples: <FromFaxNum:520-321-7461>
<FROM_FAXNUM:My Personal Fax Number>

This code specifies the sender's fax number.    The data specified using this code is placed verbatim onto 
the fax coversheet.    If this code is not specified, the default specified in Options-Cover Sheet Information 
is used.



FROMGENFAXNUM

Examples: <FromGenFaxNum:520-321-7456>
<FROM_GENFAXNUM:520-321-7456>

This code specifies the sender's company fax number.    The data specified using this code is placed 
verbatim onto the fax coversheet.    If this code is not specified, the default specified in Options-Cover 
Sheet Information is used.



FROMGENPHONE

Examples: <FromGenPhone:520-327-1357>
<FROM_GENPHONE:520-327-1357>

This code specifies the sender's company phone number.    The data specified using this code is placed 
verbatim onto the fax coversheet.    If this code is not specified, the default specified in Options-Cover 
Sheet Information is used.



FROMNAME

Example: <FROMNAME:Albert Einstein>
<FROM_NAME:Albert Einstein>

This code specifies the sender's name.    The data specified using this code is placed verbatim onto the 
fax coversheet.    If this code is not specified, the default specified in Options-Cover Sheet Information is 
used.



FROMPHONE

Example: <FromPhone:520-327-1357 extension 277>
<FROM_PHONE:520-555-1203>

The sender's phone number.    The data specified using this code is placed verbatim onto the fax 
coversheet.    If this code is not specified, the default specified in Options-Cover Sheet Information is 
used.



GRAPHIC

Example: <GRAPHIC:logo>

A graphic object is a small picture such a logo or an icon.    The code <GRAPHIC:EARTH> embeds the 
picture specified by the text argument at the place where the code appears.    If there is an error in the 
code, the command is ignored.    Graphic objects can be setup by your system administrator.    The 
location within the document of the <graphic:xxx> code determines the location of the graphic object 
when imaged by the fax server.    This is the only code, besides <SIGNATURE:xxx> which is sensitive to 
location.



LIBDOC

Example: <LIBDOC:infopk1>

Instructs RightFAX to send a library document instead of converting the printed output from the 
application into a fax.    Any text from the document that contains this code is discarded.    Multiple library 
documents may be named, or strung together, by including multiple codes, for example:

<LIBDOC:INFOPK1><LIBDOC:PRICES><LIBDOC:ORDERFORM>
<TO_NAME:John Doe><TO_FAXNUM:555-1234><COVER>
John, here is the information you requested on our new widget assembly. 

 I've included the current price list and an order form for your convenience.

These codes would cause the INFOPK1, PRICES, and ORDERFORM library documents to be 
assembled onto a single fax.    The note to "John Doe" would be discarded.    A cover sheet would be 
automatically added by the fax server because of the <COVER> code and the fax would be sent to John 
Doe at 555-1234.    The LIBDOC code differs from the LIBDOC2 code in that the text "John, here is..." is 
discarded.

See also: <LIBDOC2>



NEWLIB

Example: <NEWLIB:TESTLIB,Test_Library>

<NEWLIB:id,description>

This code allows Library Documents to be created and/or updated simply by printing to a network print 
queue.    The functionality works with PostScript and PCL-5 printer emulation. 

Note: Any print job containing this code will automatically remove the "fax" from a user's mailbox, after it is 
successfully converted into fax format and checked into the library database.



NOCOVER

Example: <NOCOVER>

Turns off automatic cover sheet generation only for the fax generated by the document containing this 
embedded code.    This code is useful if the default setting is to send coversheets and you would like to 
send this fax without a cover sheet.    The code will not change the default setting;      You may use FaxUtil 
to do that.

Note:    The use of this command does not relieve the user of the responsibility for supplying the required 
fax information, such as the recipient's name and fax number.    Which would need to be specified using 
<TONAME:Jim Shaw> etc.

See also:                <FCSFILE>
<COVER>



NOBODY

Example: <NOBODY>

Tells RightFAX to fax only the cover sheet, and not include a fax body document.    Any codes in the 
document that are not used for the production of the cover sheet will be ignored.    If NOBODY is used in 
conjunction with LIBDOC, LIBDOC2, ADDDOC, or ADDDOC2, the functionality of these codes is negated.



NORMAL

Example: <NORMAL>

Tells the fax server to convert the body of this fax into Normal (200 x 100 DPI) mode.    This code 
overrides the default mode set with the FaxUtil program.

See also: Fax Resolution 
<FINE>



NOTE

Example: <NOTE:So how's the weather there?>

This code is used to add comments to your cover sheet.    You may use as many as 21 Note codes in a 
single document if you want to enter multi-line comments, e.g.: 

<NOTE:The quick brown fox jumped over the lazy>
<NOTE:dog.    Now is the time for all good men to come>
<NOTE:to the aid of their country.>

Each line is limited to 69 characters.



PREVIEW

Example: <PREVIEW>

Holds the fax for preview before sending it.    Use the Release command to allow the fax server to begin 
sending the fax, assuming you are satisfied with its appearance.    If you decide to not send the fax, you 
may simply delete it.    You cannot edit the fax information as the fax is considered "complete".    You may 
use Forward To Fax Machine to create a copy that can be edited.

See also: Hold for Preview 



SAVE

Example: <SAVE>

Specifies that this fax should NOT be deleted after being sent; overrides any default auto-delete setting.

See also:  Auto Delete Options 
<DELETE>
<DELETEALL>



SIGNATURE

Example: 
Sincerely,
<SIGNATURE:JDOE>

 
 

John Doe

RightFAX allows you to store scanned images of signatures in the system, and insert them into fax 
documents.    The Signature code specifies which signature image to use and the signature will be 
inserted into the document at the location of the signature embedded code statement.    Multiple signature 
codes per document are supported.    You must be authorized to use a given signature or it will not appear 
on the fax.



TOCITYSTATE

Example: <TOCITYSTATE:Peoria, IL>
<To_CityState:Peoria, IL>

This code specifies the recipient's location, address, or any other relevant information you wish to convey. 
The data specified using this code is placed verbatim onto the fax coversheet.



TOCOMPANY

Example: <TOCOMPANY:Acme Flooring> 
<To_Company:Acme Flooring>

This code specifies the recipient's company or any other relevant information you wish to convey.    The 
data specified using this code is placed verbatim onto the fax coversheet.



TOCONTACTNUM

Example: <TOCONTACTNUM:520-327-1357> 
<To_ContactNum:520-327-1357>

This code specifies the recipient's voice phone number or any other relevant information you wish to 
convey.    The data specified using this code is placed verbatim onto the fax coversheet.



TOFAXNUM

Example: <TOFAXNUM:1-520-321-7456> 
<To_FaxNum:1-520-321-7456>

Indicates which phone number to dial when sending the fax.    The following are the valid characters which 
may be used:

Character Meaning
0 through 9 Phone numbers and access numbers
, (comma) 1.5-second pause
I 5-second pause
W Wait up to 15 seconds for a dial tone
P Pulse dialing mode
T Tone dialing mode (default)
! Hook-flash signal
* Generates tone as would '*' button on Touch-Tone phone
# Generates tone as would '#' button on Touch-Tone phone
@ Causes all following digits to be hidden on fax cover sheet
{ Causes dialing prefix to NOT be prepended
} Causes dialing postfix to NOT be appended
A through H Dialing Macros (defined by administrator)



IGNORE

Example: <IGNORE> 

Causes the fax server to stop scanning for further embedded codes.    In the following example, the 
<To_FaxNum:555-1234> code will not be parsed by the fax server and will appear in the fax image:

<TO_NAME:John Doe><IGNORE><To_FaxNum:555-1234>

This code is useful when attempting to fax instructions on how to use embedded codes.



TONAME

Example: <TONAME:Chuck Lemon> 
<To_Name:JDOE>

If the name specified matches one of your phonebook ID's, then RightFAX automatically uses the 
corresponding Phonebook entry or group to send this fax.    Otherwise, the name will be placed verbatim 
on the fax cover sheet.    If you wish to use a entry or group from another user's phonebook, use the 
syntax, "UserID!EntryID".    Only published phonebook entries of other users may be referenced.



Error and Status Messages

These are messages that you may receive during the course of a fax transmission.    Depending on the 
nature of the message, you may need to use FaxUtil to make changes to your fax.

A new fax has arrived for (user ID) from remote ID:(remote ID) 
A new fax has arrived for (user ID) which hasn't been viewed or printed 
A new fax has arrived from remote ID: (remote ID) 
An outgoing fax is ready for previewing 
Answer tone not detected 

Bad Formtype 
Bad Phone Number 
Bad Signature Code 

Call answered before one full ring 
Carrier not detected 
Command time exceeded 
Command time too short 
Command timeout 
Communications-line failure 
Conversion Failed 

Dial failure or no dial tone 
Duplicate 

Equipment busy tone detected 

Fax Number Busy 
Fax to (name) abandoned, too many retries 
Fax to (name), (error) 
Function not implemented 

G2 Fax Machine 

Held for Preview 
Human Answered 

Illegal line number 
Illegal option in call 
Illegal parameter value 
Illegal Sig. Use 
Imaging error encountered, fax abandoned 
In Conversion 
Info Not Complete 
Initial Processing 
Invalid Billing Code 

Loop current detected 
Loop current failed 
Loop current not detected 

Needs Attachment 
Network congestion detected 
Network high and dry (no ring)
No Answer at Fax # 



No answer tone detected 

OCR Error 
OCR in Process 
OK 
One of your outgoing faxes needs attention 

P2 was not detected at the end of training 
Phone Line Problems 
Poor Quality 
Printing 
Printing Error 
Protocol reject message 
Protocol timeout 

Queued for OCR 
Queued for Printing 

Ringback signal detected 
Ringback, but no answer tone 
Ringback, then busy condition 

Scheduled for Send 
Scheduling Failed 
Sending 
Sending fax to (name) at (faxnumber) 

Thermal Record 
Training Algorithm detected FSK 
Training Algorithm found on PN 
Tx/Rx Error 

Unknown Error 
Unknown Error Code 
Unknown Status Code 

Voice response to call 
Waiting for Conversion 
Waiting to be Sent 

Your fax has been successfully sent to (name) at (faxnumber)
Your outgoing fax contains an invalid billing code



A New Fax has Arrived for (user ID) from Remote ID: (remote ID).

This means that someone else has selected you as their alternate for notification, and that they have 
received a new fax.    You do not have to take any action on this message; it is merely an informational 
message. 

A Remote ID is the message that the sending fax machine gives to RightFAX to tell where the fax is 
coming from.    This may be in the form of that fax phone number or an alphanumeric message, 
depending on how that fax machine is configured.



A New Fax has Arrived for (user ID) which hasn't been Viewed or Printed

This means that you have been assigned to the position of RightFAX Administrator or Alternate 
Administrator for a user group, and that one member of that group has received a fax and has not viewed 
or printed it within one hour of receipt.

If you are setup to be an Administrator or Alternate Administrator, you can switch to that user's fax mailbox 
and take appropriate action on the new fax.    If you have Administrative privileges in RightFAX, you will 
not be required to supply a password. 

Note: A group administrator does not automatically have administrative privileges.



A New Fax has Arrived from Remote ID: (remote ID).

You have received a new fax.    You will continue to be notified for one hour (or however much time your 
system administrator has specified) about the fax.    If you do not view or print the fax, your RightFAX 
group's Administrator will be notified.    If he or she does not view or print the fax, the group's Alternate 
Administrator will be notified.

A Remote ID is the message that the sending fax machine gives to RightFAX.    This message may 
consist of that fax machine's phone number or a pre-programmed alphanumeric sequence.



An Outgoing Fax is Ready for Previewing

You have sent a document through RightFAX, which has finished processing both the body of the fax and 
its cover sheet.    You have specified that you would like to hold the fax for previewing before it is sent.

You must use FaxUtil (RightFAX) to view the fax and then select Release.

Hold for Preview 
Release 



Answer Tone Not Detected

RightFAX could not connect with the remote (receiving) fax machine.    The remote machine did not talk to 
RightFAX properly.    RightFAX could not complete the call.

Solution:
If the fax has been tried five times and failed five times, call the recipient and verify the fax number and 
the status of their fax machine or modem.



Bad Formtype

You have specified either through embedded codes or the Fax Information window that you would like to 
overlay a letterhead or other type of form onto your fax.    Unfortunately, you have specified a form that 
does not exist or has a problem. 

Solution:
Check to make sure that you typed the Form ID correctly and that the form does actually exist.    If 
everything seems to be in order, there could be something wrong with the form itself.    Talk to your system 
administrator.



Bad Phone Number

The phone number you entered was incorrect.

Solution
Check the phone number for the correct digits.    To correct the phone number, highlight the failed fax and 
select Forward to Fax Machine from the Fax menu.    RightFAX will create a new fax and will pop up a 
new Fax Information window with a blank Fax Number field.    Fill in the correct number and press OK.



Call Answered Before One Full Ring

This error denotes that RightFax did not receive a normal ringback signal generated for a long enough 
period of time from the phone company's Central Office.

Solution
This is a receiving station problem and must be corrected by the recipient.    They must configure the fax 
device to let the phone ring at least once before going off hook.



Carrier Not Detected

RightFAX did not hear any dial tone when it tried to dial out.

Solution
Check the phone lines with a regular phone; see if you can detect a dial tone and dial a long distance 
number.
Check to be sure that the fax card is properly connected to the phone line; no loose connections, etc.



Command Time Exceeded

This is a timing related error that may be caused when a GammaLink card is waiting for or sending some 
type of command (T30 protocol handshaking commands) and a response does not occur within a given 
period of time.

Solution
Try sending your fax again after confirming the phone number and operation of the remote machine.



Command Time Too Short

This error is a timing related error.    It can be caused when the GammaLink card is waiting for or sending 
some type of command (T30 protocol handshaking commands) and a response does not occur within a 
given period of time.

Solution
Try sending your fax again after confirming the phone number and operation of the remote machine.



Command Timeout

This error is a timing related error.    It can be caused when the GammaLink card is waiting for or sending 
some type of command (T30 protocol handshaking commands) and a response does not occur within a 
given period of time.

Solution
Try sending your fax again after confirming the phone number and operation of the remote machine.



Communications-Line Failure

The GammaLink card was unable to make a valid connection with the remote machine.    Check the lines 
for anything unusual and try your call again.



Conversion Failed

RightFAX was unable to convert your document from the PCL5 or PostScript print format to its Group III 
format.

Solutions
Are you using the correct driver for this type of conversion?    For example, if your fax queue is an HP 
LaserJet queue, are you using a PLAIN LaserJet III driver (NOT a II, IIId, or 4 driver)?

What kind of document are you trying to fax?    Does it have a lot of complex graphs, charts, and/or 
graphics?    Can other documents without these features convert correctly?    If so, contact your RightFAX 
administrator to see if you are running the latest possible conversion engines, which may be more 
complete than the current one.

Administrative Tips
Check to make sure that the correct WorkServer for the job is running; i.e. are you doing PCL5 
conversions?    If so, your WorkServer (on the Fax Server) must be configured to do PCL5 conversions, 
and it must be running.

Check your cover sheet; can it convert correctly alone WITHOUT the attached document?    If not, then 
you should check to make sure that your cover sheet was created correctly and that the WorkServer is 
configured to do "COVERSHEETS" conversions.

If all else fails, have your RightFAX administrator set the WorkServer log level to 2 and restart the Fax 
Server.    More information about log levels and the RightFAX.INI file can be found in the RightFAX 
Installation and Administration Guide.    Have the administrator contact RightFAX Technical Support.



Dial Failure or No Dial Tone

This may be caused by two things; there is no dial tone, or the T1 GammaLink card is configured 
incorrectly.

Solution
Contact RightFax Technical    Support for help.



Duplicate

This is not an error; someone else (or yourself!) has forwarded an existing fax to you.    The original copy 
remains in their mailbox and will not be deleted if you delete this copy.



Equipment Busy Tone Detected

The receiving machine's phone line is busy.    Try your call again later.



Fax Number Busy

RightFAX has tried to send your fax the required number of times (the default value for this is 5) and each 
time, the phone number was busy.      Try dialing the number by hand to see if you do indeed get a busy 
signal.    If not, highlight the fax and select Kick Fax from the File Menu; this will try to send the fax one 
more time.

If RightFAX still cannot send the fax, call the intended recipients and ask them to check their fax machine; 
it may be failing somehow.

If you STILL cannot send, contact your RightFAX administrator, who can run physical checks on the fax 
cards.

Administrative Tips
To run physical checks on your fax boards, see the chapter entitled "Testing the Fax Hardware" in the 
RightFAX Installation and Administration Guide.



Fax to (Name) Abandoned, too Many Retries

RightFAX will try to send your fax a certain number of specified times.    The default value is 5 times, 
although your administrator may have changed this.    If for some reason, RightFAX cannot get a 
complete fax through to the receiving machine after this number of retries, it will "abandon" the fax, or fail 
it.

Solutions
Check the phone number to which you are sending.    Does it have all required prefixes, 
postfixes, etc. and is it correct?    Can you dial this number by hand and hear the fax tone on the 
other end?

Can you send from a regular fax machine to the receiving number?    If not, then it's a problem with that 
number, not with RightFAX.

If this all fails, contact your RightFAX administrator to see if he or she can physically test the boards.

Administrative Tips
To run physical checks on your fax boards, see the chapter entitled "Testing the Fax Hardware" in the 
RightFAX Installation and Administration Guide.



Fax to (Name), (Error)

Your outgoing fax encountered the error listed.    If the error is not listed in this help file, contact your 
RightFAX administrator for any help you may need.



Function Not Implemented

This means that an operation was attempted that was not currently supported in the GammaLink 
software.    An example would be the ANSWER IMMEDIATELY option.

Solution
Do not attempt to use FAXM to do this type of operation, and if you are using the GPI, do not allow these 
types of operations to be put in the queue record OPERATION field.



G2 Fax Machine
 
You have attempted to send a fax to a Group II machine, rather than a Group III machine, which is the 
type that RightFAX uses.    You should contact the intended recipient and see if they have any other 
available fax machines.



Held for Preview

This is not an error; you have specified either with embedded codes or in the Fax Information dialog box 
that you want to Hold this Fax for Preview.

Solution
To send the fax after all information is complete, highlight this fax, and then select Release from the Fax 
Menu.



Human Answered

RightFax detected a sound that it didn't expect after it dialed your sending phone number.    The unknown 
sound could indeed be a human voice, or it could be a recording or some kind of line noise.

Solution
Check your phone number again; does it contain all required prefixes and postfixes, etc.?    If you dial this 
number by hand, do you hear anything out of the ordinary before the ring starts?    If so, try adding an "i" 
after the phone number in the Fax Information window; this "i" causes RightFax to ignore all line noise for 
5 seconds after it dials the phone number.



Illegal Line Number

This means that someone attempted to send a fax out on a fax channel that does not exist.    This could 
occur if someone using the GammaLink GPI put an invalid value in the MODEMID field of the queue 
record.    It could also occur in GCL if someone used the MODEMID command and specified an invalid 
channel.

Contact RightFax Technical Support. 



Illegal Option in Call

This error could occur if an invalid parameter is given for one of several different commands including:

Log
Debug
Xfer
Send.

Contact RightFax Technical Support.



Illegal Parameter Value

This error could occur if an invalid parameter is given for one of several different commands including:

Log
Debug
Xfer
Send.

Contact GammaLink Technical Support at (408) 745 2250.



Imaging Error Encountered, Fax Abandoned

We were unable to convert your document from the PCL5 or PostScript print format to our Group III 
format.

Solutions
Check your cover sheet; can it convert correctly alone WITHOUT the attached document?    If not, then 
you should check to make sure that your cover sheet was created correctly and that the WorkServer is 
configured to do "COVERSHEETS" conversions.

What kind of document are you trying to fax?    Does it have a lot of complex graphs, charts, and/or 
graphics?    Can other documents without these features convert correctly?    If so, contact your RightFAX 
administrator to see if you are running the latest possible conversion engines, which may be more 
complete than the current one.

Administrative Tips
Check to make sure that the correct WorkServer for the job is running; i.e. are you doing PCL5 
conversions?    If so, your WorkServer (on the Fax Server) must be configured to do PCL5 conversions, 
and it must be running.

If all else fails, set the WorkServer log level to 2 and restart the Fax Server.    More information about log 
levels and the RightFAX.INI file can be found in the RightFAX Installation and Administration Guide. 



In Conversion

This means that RightFAX is converting your document from a print file format to a faxable Group III 
format.    Normally RightFAX should keep your document in this state for only a little while, unless it's an 
extremely complex page with lots of graphics.

Solutions
If your document or cover sheet never leaves the 'In Conversion' status, you need to contact the 
RightFAX administrator to find out whether WorkServer is running and whether it is configured to perform 
the correct types of conversions.    For more information on this, see the RightFAX Installation and 
Administration Guide.



Info Not Complete

This means that you have not completed all required information for RightFAX to send the fax.    Edit the 
cover sheet by highlighting the fax, then pressing the Enter key or double clicking on that fax.    You 
should see a window entitled Fax Information , in which you can change any relevant information.    Any 
italicized fields must be completed; clicking on the 'More' button displays information about you, the 
sender.



Initial Processing

This means that RightFAX is checking your document for embedded codes, and is counting the number 
of pages.    Status should soon change to Info Not Complete or Waiting for Conversion, or In Conversion, 
depending on whether you used any embedded codes.

See also: Embedded Codes 



Invalid Billing Code

You have entered a billing code that is not listed or is incorrect.

Solution
To check against a list of currently available billing codes, Edit the fax by highlighting it, then pressing the 
Enter key or double clicking on that fax.    You should be presented with the Fax Information window ; 
press the Lookup button, and enter the first few numbers or letters of the billing code you want to use.    A 
list of all billing codes that start with the sequence that you entered will appear; choose the desired code 
and click OK or press the Enter key.



Loop Current Detected

When we attempt to go off-hook to send a fax, we find that the phone is already off-hook since we find 
loop current on the phone line.    This can occur when 2 devices are sharing a phone line (e.g. by using a 
T-splitter) and one device is using the line and the GammaLink card attempts to use it.

It could also mean a    CP4 configuration error.    This usually occurs in T1 environments when the 
GammaLink card or the T1 phone line is not configured correctly.    Call GammaLink Technical Support at 
(408) 745 2250.



Loop Current Failed

Means that the GammaLink card didn't detect a valid value for LOOP CURRENT.    The card DID detect 
current on the line, but it was not a valid value.

Solution
Have the phone line checked.



Loop Current Not Detected

Means that the GammaLink card was looking for LOOP CURRENT before it attempted to dial the phone 
and it didn't find any.    On T1 configurations with the MLCP/4 cards, loop current is not detected in the 
same way that it is for most other GammaLink cards - therefore loop current detection should be turned 
off in this case.

Solution
If not a T1-MLCP/4 configuration, have the phone line(s) checked.
If it is a T1-MLCP/4 configuration, turn off LOOP CURRENT detection by using the following command at 
the Fax Server:

MODEMCTRL <c> 1040 0 (where c represents the channel number.)



Needs Attachment

You have specified with embedded codes that you    want to attach a scanned document to the existing 
fax.

If you don't really need an attachment, highlight the fax and forward it to yourself. 

If you do need an attachment, highlight the fax, edit it by choosing Edit from the Fax menu, and then 
choose the desired attachment from the Forms list, or by pressing the Scan button and scanning the 
desired document from an attached scanner.



Network Congestion Detected

This can be caused by two things;

Network congestion really did occur, in which case it has nothing to do with either RightFAX or the 
GammaLink card, but your network.    Have the system administrator run diagnostic tests of the 
connections, etc on your network.

An invalid phone number was dialed.    You would hear the standard phone company message "I'm sorry. 
The phone number you have dialed is no longer in service..." etc.



Network High and Dry (No Ring)

This means that the GammaLink card doesn't detect any type of telephone interface available.    This is a 
very serious error.

Solution
Check the phone line by using a handset plugged into the same wall outlet and see if any dial tone is 
heard.    If dial tone is heard from the handset, call GammaLink technical support at (408) 745-2250.



No Answer at Fax #

the fax machine at the receiving end didn't answer or a wrong number was dialed.    Double check your 
fax number and try it again or try dialing it with a handset; you may wish to contact the recipient to have 
them check their fax machine.



No Answer Tone Detected

This means that the phone is ringing at the destination but the fax machine is not answering within the 
specified time.    This can happen quite a bit in international calling when it can take up to a minute to 
connect to the remote station.    It could also occur if the remote machine is off line.

Administrative Tips
Have your RightFAX administrator increase the CD_TIMEOUT value in the queue record (it defaults to 30 
seconds.)    This is commonly called the CARRIER DETECT time.

Check if the remote machine is off line.



OK

Means what it says.    Your fax went correctly!



One of Your Outgoing Faxes Needs Attention

This means that you have not completed all required information for RightFAX to send the fax.    You will 
need to use RightFAX (FaxUtil) to edit your fax. Edit the cover sheet by highlighting the fax, then pressing 
the Enter key or double clicking on that fax.    You should see a window called Fax Information, where you 
can add or change any information.    All italicized fields must be completed; clicking on the 'More' button 
displays information about you, the sender.



P2 Was Not Detected at the End of Training

This type of training error indicates a performance problem with the Fax Server and the number of fax 
cards that it contains.    It will most often be seen in 16-32 channel systems or very slow computers.

Solution
Call GammaLink Technical Support at (408) 745 2250 for help on chassis configuration and 
troubleshooting.



Poor Quality

There was too much line noise for the fax to be transmitted correctly.    The fax probably sent, but it would 
have been difficult to read or decipher.    Try sending your fax again or having the remote sender try again.



Protocol Reject Message

This is a a generic protocol error code that can mean pretty much anything.    Basically, your fax board is 
having problems talking to the remote fax machine; it didn't get the signals that it expected.



Protocol Timeout

This is a a generic protocol error code that can mean pretty much anything.    Basically your fax card isn't 
receiving the signals that it expects from the remote machine. 



Ringback Signal Detected

This means that Ringback was detected and shouldn't have been.    This could occur if someone was 
sharing a phone line and the GammaLink Card attempted to dial and found that there was already a call 
in progress and that it was ringing at the remote station.    This can happen using the MLCP/4 board and a 
T1 board when there is a lot of noise on the T1 phone line.

Solution
Check all phone connections to the GammaLink card.



Ringback, But no Answer Tone

The phone rang at the destination, but nothing ever answered the phone.    These generally mean that the 
receiving fax machine is off line and unable to receive faxes.



Ringback, then Busy Condition

This means that a phone number was called and went off hook and then went on hook very quickly, thus 
generating a fast busy signal.    This happens most often when a phone number is called, a person 
answers and discovers that a fax machine called, and then hangs up very quickly.

Check the number that you have told RightFAX to dial; make sure it contains all required prefixes and 
postfixes, etc. and that it is correct.



Scheduled for Send

This means that your document was successfully converted to the RightFAX Group III format and is now 
being sent to the fax card to await sending.    Depending on the outgoing load on the fax card, your fax 
may be sent immediately, or may remain in this state for some time.    If, however, your fax remains 
"Scheduled to Send" for many hours, you may have encountered a problem.



Scheduling Failed

This means that your document was converted correctly, but that it couldn't be correctly queued to the fax 
cards.

Administrative Tips
Most probably, the RightFAX.INI file is incorrect.    Have your RightFAX administrator double-check the 

line that reads "remote_imagedir=xxxx" in this file.    Correct usage of this line is detailed in the 
RightFAX Installation and Administration Guide.

Have your RightFAX administrator check to make sure that the Board Server is running (this will be 
GammaServ if you have GammaLink cards, or BrookServ if you have Brooktrout cards.)

Check to make sure all is configured correctly in the FAXHW.INI file on the Fax Server.

Consult the RightFAX Installation and Administration Guide for further tips on your fax boards.



Sending

Your fax is on its way!



Sending Fax to (Name) at (Number)

Your fax is on its way!



Thermal Record

This means that you have recorded a fax that came through a fax machine into the RightFAX database.    
Note that unless you have scanned this fax into RightFAX, you will NOT be able to view this fax; it exists 
only as a record.



Training Algorithm Detected FSK

This type of training error indicates a performance problem with the Fax Server and the number of fax 
cards that it contains.    It will most often be seen in 16-32 channel systems or very slow computers.

Solution
Call GammaLink Technical Support at (408) 745 2250 for help on chassis configuration and 
troubleshooting.



Training Algorithm Found on PN

This type of training error indicates a performance problem with the Fax Server and the number of fax 
cards that it contains.    It will most often be seen in 16-32 channel systems or very slow computers.

Solution
Call GammaLink Technical Support at (408) 745 2250 for help on chassis configuration and 
troubleshooting.



Tx/Rx Error

Transmission/Reception Error:    This means that somehow something went wrong; most probably the 
remote end was experiencing difficulties.    This could, however, be due to excessive line noise, etc.

If this happens all the time, contact the RightFAX administrator, as you may have a problem with your 
cards and/or the phone lines.



Voice Response to Call

This means that RightFAX got a sound that it didn't expect after it dialed your sending phone number.    
The unknown sound could indeed be a human voice, or it could be a recording or some kind of line noise.

Solution
Check your phone number again; does it contain all required prefixes and postfixes, etc.?    If you dial this 
number by hand, do you hear anything out of the ordinary before the ring starts?    If so, try adding an "i" 
after the phone number in the Fax Information window; this "i" makes RightFAX ignore all line noise for 5 
seconds after it dials the phone number: handy for European calls.



Waiting For Conversion

This means that RightFAX is busy with another process and has queued your document to be converted. 
This isn't an error, unless your document never leaves this status.

Solutions
If your document or cover sheet never leaves the 'Waiting for Conversion' status, you need to contact the 
RightFAX administrator to find out whether RightFAX WorkServer is running and whether it is configured 
to perform the correct types of conversions.    For more information on this, see the RightFAX Installation 
and Administration Guide.



Your Fax has been Successfully Sent to (name) at (faxnumber).

This means that your fax arrived correctly at its destination; this is just a way of letting you know.



Your Outgoing Fax Contains an Invalid Billing Code

This means that your company has required you to enter a billing code or matter number for each 
outgoing fax, and that you have either not entered one, or entered it incorrectly.

Solution
To check against a list of currently available billing codes, Edit the fax by highlighting it, then pressing the 
Enter key or double clicking on that fax.    You should be presented with the Fax Information ; press the 
Lookup button, and enter the first few numbers or letters of the billing code you want to use.    A list of all 
billing codes that start with the sequence that you entered will appear; choose the desired code and click 
OK or press the Enter key.
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Toolbar

At the top of the RightFAX mailbox but below the menus, you will notice a toolbar; the buttons on it are 
shortcuts to many common menu choices.

 New 

 Delete 

 View 

 Print 

 OCR 

 Forward to Network User 

 Forward to Fax Machine 

 Route to Network User 

 Show Transmission History 

 Combine 

 Phonebook 

 Update 



Unknown Error Code

Error condition is not known. 

Solution: 
Try again.    If error persists, check with your Fax Administrator or contact RightFax technical support.



Phone Line Problems

The FaxServer is having trouble with the phone lines. 

Solution:
Either there is no loop current or the lines are not connected properly.    See your Administrator or contact 
RightFax technical support.



Bad Signature Code

The signature code is incorrect.

Solution:
The signature code that was entered is not recognized as a valid signature identifier.    Check the 
signature code and try again.    If error persists contact your RightFax Administrator or RightFax Technical 
Support.



Illegal Sig. Use

You may be trying to use a Signature File that you are not authorized to use. 

Solution:
Check the Signature code and try again or contact your RightFax administrator.



OCR Error

An error occurred while a document was being sent to or was at the the Optical Character Recognition 
module of RightFax.

Solution:
Contact your RightFax Administrator or RightFax Technical Support.



Printing error

An error occurred while printing.

Solution: 
Contact your RightFax administrator.



Waiting to be Sent

The fax has not yet been scheduled for faxing.

Solution: 
This is not a problem unless this message stays up for an abnormal amount of time.    If this occurs 
contact you RightFax Administrator.



Unknown Error

Undetermined error.

Solution: 
Contact you RightFax administrator or RightFax technical support.



OCR in Process

The document is queued and is being processed by the OCR module.

Solution: 
This is not a problem unless the message remains for an abnormal amount of time.    If this does occur 
contact your RightFax administrator or RightFax technical support.



Printing

Document is being printed.

Solution:
This status is not an error.



Queued for Printing

Document has been queued and is waiting to be printed.

Solution:
This is not a problem unless this message remains for an abnormal amount of time.



Queued for OCR

The document has been queued and is waiting for the ORC module to convert it.

Solution:
This is not an error unless it remains for an extended period of time.    If this occurs then contact your 
RightFax administrator.



Unknown Status Code

An unknown status code has been returned to RightFax from your fax card.

Solution:
Contact your RightFax administrator or RightFax technical support.



ADDDOC

Examples: <ADDDOC:X:\BIN\XYZ.TIF>
<ADDDOC:\\SERVER2\VOL1\IMAGES\PRICES.PCL>

Tells RightFAX to append another file to the end of the fax.    This additional file    needs to be in TIFF-G3, 
DCX, PCX, RightFAX G3, PCL-5,Text, ASCII or PostScript format.    More than one ADDDOC code can 
appear in the main document; the additional files will be appended in the order that they appear on the 
main document.

In one of the above examples, the file to attach is named with a UNC specification.    This is 
recommended instead of a drive letter as the mapping, or drive links, may be different for the fax server 
versus the machine on which the fax output originates.    For example, \
\SERVER1\SYS\USERDIRS\BOB\MYFILE.TIF may appear to the user Bob when he is logged in as H:
\MYFILE.TIF.    If <ADDDOC:h:\myfile.tif> were used by Bob, the fax server would not pick up Bob's TIFF 
file because the fax server has a different mapping on its H: drive.    Instead, Bob should use <ADDDOC:\
\server1\sys\userdirs\bob\myfile.tif> to specify the file unambigiously.

See also:                <ADDDOC2>
<LIBDOC>
<LIBDOC2>



UNC -- Universal Naming Convention.    A syntax used by networking operating systems (Netware, LAN 
Server, NT, LAN Manager, etc.) to specify a network server, volume or sharename, directories, 
and file name.    For Netware, the syntax is as follows:

\\SERVERNAME\VOLUME\DIRECTORY\FILE.EXT

Notice that the VOLUME does NOT have a colon, i.e. \\server\sys:\dir\file.ext is incorrect.    For 
all other networks, the syntax is:

\\SERVERNAME\SHARENAME\DIRECTORY\FILE.EXT

Most OS/2 program, some DOS programs (including the DOS prompt), some Windows 
programs, and all Windows-95 programs accept UNC syntax where ever a file can be specified. 
On Netware DOS/Windows workstations, VLM's must be used to get UNC capabilities.



ADDDOC2

Examples: <ADDDOC2:X:\BIN\123.TIF>
<ADDDOC2:\\bigserv\sys\userdirs\jdoe\help.txt>

Tells RightFAX to replace the output file with the specified file.    The specified file must be TIFF-G3, DCX, 
PCX, RightFAX G3 (*.301), PCL-5, Text, ASCII, or PostScript format.    More than one ADDDOC2 code 
can appear -- the additional files will be appended in the order that they appear.

In one of the above examples, the file to attach is named with a UNC specification.    This is 
recommended instead of a drive letter as the mapping, or drive links, may be different for the fax server 
versus the machine on which the fax output originates.    For example, \
\SERVER1\SYS\USERDIRS\BOB\MYFILE.TIF may appear to the user Bob when he is logged in as H:
\MYFILE.TIF.    If <ADDDOC:h:\myfile.tif> were used by Bob, the fax server would not pick up Bob's TIFF 
file because the fax server has a different mapping on its H: drive.    Instead, Bob should use <ADDDOC:\
\server1\sys\userdirs\bob\myfile.tif> to specify the file unambigiously.

Note: ADDDOC2 will cause the fax server to delete the specified file after it has been attached.    If you do 
not want this to occur, the specified file should be marked as Read-Only.

See also:                <ADDDOC>
<LIBDOC>
<LIBDOC2>



LIBDOC2

Example: <LIBDOC2:INFOPK1>

Instructs the fax server to attach a library document to the output from the application, i.e. the named 
library document is attached onto the end of the document containing the LIBDOC2 code.    Multiple 
library documents may be named, or strung together, by including multiple codes, for example:

<LIBDOC2:INFOPK1><LIBDOC2:PRICES><LIBDOC2:ORDERFORM>
<TO_NAME:John Doe><TO_FAXNUM:555-1234><COVER>
John, here is the information you requested on our new widget assembly. 
I've included the current price list and an order form for your convenience.

These codes would cause the INFOPK1, PRICES, and ORDERFORM library documents to be 
assembled onto the end of the fax with the note to "John Doe".    A cover sheet would be automatically 
added by the fax server because of the <COVER> code and the fax would be sent to John Doe at 555-
1234.    The LIBDOC2 code differs from the LIBDOC code in that the text "John, here is..." is not 
discarded.



FCSFILE

Example: <FCSFILE:mycover1.pcl>

Instructs the fax server to use MYCOVER1.PCL as the cover sheet.    The coversheet model specified 
must exist in the \RIGHTFAX\FCS directory.    If the FCSFILE code is not present in a document, the 
user's default will be selected automatically.    If the user does not have a default coversheet, the 
coversheet of the group to which the user belongs will be selected.    If the group does not have a 
coversheet, then FCS.PCL will be used.

See also:                <COVER>
<NOCOVER>



COVER

Example: <COVER>

Turns on automatic cover sheet generation only for the fax generated by the document containing this 
embedded code.    This code is useful if the default setting is to not send coversheets and you would like 
to send this fax with a cover sheet.    The code will not change the default setting;      You may use FaxUtil 
to do that.

See also:                <FCSFILE>
<NOCOVER>



CHANNEL

Example: <CHANNEL:3>

The CHANNEL code tells RightFAX to send this fax out on the specified channel.    This code would be 
useful if your company uses one channel for priority faxing, and you want this fax to go out right away; 
with the CHANNEL code you can tell RightFAX to use that channel instead of the first available channel. 
Or, you can use this code to specify to use a channel which has been designated only for broadcasting, 
leaving the others free for single faxing.

The number listed in the Channel code should be 1 through the number of channels installed on the fax 
server.    The code <CHANNEL:0> indicates that the fax can be sent on any channel.    If a fax is targeted 
against a channel which does not exist or does not have send capabilities, the fax will not be sent and will 
stay in the status, "Scheduled For Send".



NEWDEST

Examples: <TO_NAME:JOHN><TO_FAXNUM:555-1234><NEWDEST>
<TO_NAME:MARY SMITH><TO_FAXNUM:230-5000><NEWDEST>

The <NEWDEST> code informs RightFAX that you have specified multiple people to which to send the 
fax (any number of destinations can be specified).    Notice that a <NEWDEST> code must appear after 
each and every destination, including the last one.    Further, the <NEWDEST> code only allows certain 
codes to be repeated.    Those codes are: 

<TO_NAME:NAME>
<TO_FAXNUM:FAX NUMBER>
<TO_CONTACTNUM:NUMBER>
<TO_COMPANY:COMPANY>
<TO_CITYSTATE:LOCATION>
<BILLINFO1:INFO>
<BILLINFO2:INFO>

If any other embedded codes are used, then only the last one seen will take affect.    For example:

<TO_NAME:Bob Smith><TO_FAXNUM:458-3323><NEWDEST><TO_NAME:John 
Doe><TO_FAXNUM:555-1234><NEWDEST>
Dear Sir,

I've faxed you the information that we spoke about last week but have not heard ...

Sincerely,
Frank Brooks
<FROM_NAME:Jane><FROM_NAME:Frank>

In the above example, the name "Frank" will be picked up as the "from name" on the cover sheet.    The 
code naming "Jane" would be ignored, though it would be pulled out of the document.



Priority

This gives a priority to the outgoing fax of high, normal, or low.    In a sense, it "creates" three queues.    
The high priority faxes will fax out first followed by the normal and then the low priority.    For example if a 
low priority fax is in the queue but not yet being faxed and a higher priority fax enters the queue the high 
priority fax will be place in front of the low priority fax. 

The Priority for each fax is set in the Fax Information window and defaults to the setting in the Send Fax 
Options. 

Note the fax administrator has the ability to allow or disallow users access to high priority setting.    Also 
some fax boards do not support priorities; check with you fax administrator for more information.

See also 
PRIORITY Embedded Code



Add Entry

This Button allows you to add the currently entered information into your phone book.    If the user already 
exists it will be duplicated.    You will be notified of this if you use the same ID as the existing entry, other 
wise it will just be added.



Sorting Faxes

To sort your fax list double click on the column titles with either mouse button in the FaxUtil main window. 
Double clicking with the 1st mouse button will first sort in ascending order.    Double clicking again with the 
1st button will sort in descending order.    You may also sort in descending order by double clicking the 
2nd mouse button. 

The faxes will revert to their "natural" order anytime a new fax is received or FaxUtil is closed.    Faxes can 
be sorted in ascending or descending order by Date/Time, Sent/Received, to/from/file, or Fax Number/ID. 



Changing Mail Boxes

There are two ways to change mailboxes: Selecting Switch mailbox from the List menu or by scrolling 
through the pulldown menu of users, located to the right of the tool bar.

Note: Only Administrators can change mail boxes unless you know another's password.    There are two 
types of administrators;    Group administrator and a full administrator.    A group administrator can only 
change to mail boxes which are in the group for which he is the group administrator.    A full administrator 
can change to ANY mail box in the system.



PRIORITY

Example: <PRIORITY:High> <PRIORITY:H>
<PRIORITY:Normal> <PRIORITY:N>
<PRIORITY:Low> <PRIORITY:L>

This embedded code allows you to set the priority of the outgoing fax.    Valid values are; L, N, and H.    
Each user has a default priority which will be used if none is specified using an embedded code.    Only 
users so designed by the administrator are able to use High priority.    If you are not authorized to use 
High priority, and you include <PRIORITY:High> in a document, the fax will be forced to Normal priority.

See also: Priority of faxes



Auto-Print Setting

This setting allows automatic printing of sent faxes.    Select a destination printer, choose what to print. 
(The fax history, cover sheet, and/or the fax body)    For Successful and/or unsuccessful (failed) faxes to 
be printed.



V P B

This column in FaxUtil designates if the fax has been
 Viewed Printed of if it has a Binary attachment.



Printing Phonebooks

From the PhoneBook menu select Print, and the print dialog box will come up.    After checking the 
parameters over to check they are the way you would like them.    Select OK and all you phonebook 
entires will be printed to the selected printer.



The following tags must be present in a source TIFF file:
ImageWidth (256) value must be 1728
ImageLength (257) value must be greater than 0
BitsPerSample (258) value must be 1
Compression (259) value must be 3 (Fax compatible CCITT group 3)
FillOrder (266) value must be 1 or 2
StripOffsets (273) value must be greater than 0 (all image data must be contained in a single 

strip)
SamplesPerPixel (277) value must be 1
XResolution (282) value should be 203 if present.    Other values are not accepted.    203 will 

be assumed if tag is not present.
YResolution (283) if value is less than 150, then normal mode fax is assumed, else fine mode 

fax is assumed.    If tag is not present, then fine mode fax is assumed.




